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PRSPRS

This guide will help you get started using the PRS 

Personnel Recruitment System.

Use this guide stand-alone or in conjunction with the 

free demonstration version of the PRS which is 

available from methods: Recruitment Systems.

methods:
Recruitment Systems Limited



methods:
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PRS Primary Functions

� Interactive recruitment and HR information 

and management system

� Web vacancy publication tool

� Document management and search tool

� Performance and CRM management system

� Billing and contract management system
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Installing the PRS Demo

If you have a PRS CD-ROM 

insert it in your PC’s CD-ROM 

drive and press the Install 

PRS Demonstration Version

button.

or

Download the free 

prs_demo_setup program 

from 

http://www.methods.co.nz/

prs/downloads.htm
PRS 

Demonstration 

Setup Wizard

This wizard will step 

you through the 

installation (if you’re 

unsure which options 

to select accept the 

defaults).

PRS Setup Menu 

program (CD-

ROM only)

This program starts 

automatically after you 

insert the CD-ROM.
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Starting the PRS

Double-click the PRS 

icon on the Windows 

desktop (installed by 

the PRS setup 

program).

Select a consultant logon name 

from the drop-down list and 

press the logon button.

Consultant 

Reminders form

1

2

3

Browse your 

reminders then 

press the 

Reminders 

Close button.

Consultant Logon dialog
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The PRS Desktop

Vacancies form 

(iconized)

Sites form 

(iconized)

Personnel form
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Things you should know

Before you can enter or modify data on Personnel, Vacancies, Sites or Invoices

forms you must unlock the form by pressing the Lock/Unlock button  (or F4

shortcut key). The Lock/Unlock button is displayed with a red outline when the 

form is unlocked.

Many form-based controls pop up a control tip when the mouse pointer is 

positioned over them. A control tip window displays a short description of the 

control’s purpose.

For more tips 

see the TIPS

section of the 

PRS Essential 

Reference.

All drop-down lists have an auto-complete function, just start typing and the first 

matching item will be shown. Use this feature to avoid having to use the mouse to 

scroll through long drop-down lists.

Use the Edit menu Find...

command (Ctrl+F) to find 

matching field values in form or 

datasheet view. 

Use the Records menu Quick Sort 

commands to sort forms or datasheets by 

the current field.

Tips to help you use the PRS more effectively:

Goto buttons are everywhere, use them to drill down into the data. In addition to 

database navigation Goto buttons are used to send Email messages, open Web 

sites and dial phone numbers.

Use the Edit menu Skills 

Search... command (Ctrl+S) to 

find personnel, sites and 

vacancies with specific skills. 

Page 6



Record Lists

Record lists are common in the 

PRS. They may take up the 

whole form or may be embedded 

within a form. You can tell a 

record list by the record 

selectors in the left hand margin.

Record selectors

Delete 

record 

from list

Add new 

record to 

list

To delete a record: highlight the 

record selector with a mouse click 

then press the Delete key.

To add a new record: scroll to the 

end of the record list and enter 

record data in the empty record that 

has an asterisk in the record 

selector.

NOTE: You won’t be able to add a 

new record if the form is locked 

(press F4 to unlock).
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Saving and Undoing Changes

Saving an Edited Record

Changes to the current 

record are saved to the 

database when you:

TIP: For a full list of keyboard shortcuts see the PRS Keyboard Shortcuts

section at the back of the PRS Essential Reference.

Undoing an Edited Record

Provided you haven’t yet 

saved the current record you 

can undo changes you have 

entered:

Shift Enter+

Move to another record

Close the form or exit the PRS

Press the Shift+Enter key 

combination

(Hold down Shift and then press Enter)

Esc
Press the Escape key once to 

undo changes to the current 

field.

Esc Esc+
Press the Escape key twice to 

undo changes to all edited 

fields in the current record..

Lock the from (press the Lock 

Form button F4 or Ctrl+L)
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Form and Datasheet Views

Use the Toggle Form View

command (Ctrl+Shift+F)

from the Window menu to 

switch forms between Form 

and Datasheet views 

(Personnel, Sites, 

Vacancies and Invoice

forms).
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System Administration

The PRS Administration Guide has been written to 

assist the system administrator. It can be accessed 

on-line from the PRS Help menu (it resides in the 

shared data folder and a copy is on the PRS CD-

ROM).

The PRSMon application is 

used to administer the PRS 

shared database. PRSMon

consists of a single 

executable file (prsmon.exe) 

which is installed in the 

shared database folder by 

the PRS Shared Data Setup 

Wizard.
PRS Administration Guide

PRSMon database 

administration program
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PRS Feature Highlights
Key concepts: Personnel, Sites and Vacancies.

Built-in reminders messaging system and integrated Email management. 

Resume submission, client interview and job offer management. 

Extensive personnel and vacancy search criteria. 

Related documents can be linked to personnel, sites and vacancies and can 
be opened or Emailed directly from the PRS. 

Keyword and phrase document searches using the integrated Document 
Search Tool. 

Printed reports can be exported to HTML, Excel, text or RTF files. 

Mail-merge personnel data directly to Microsoft Word using built-in 
Document Manager. 

Off-line data access for off-site laptop operation. 

Export vacancies, personnel and reminders to Palm PCs. 

User customisable invoices and tax names.

Numerous financial, management and statistical reports.

Database audit reports. 
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Key Concepts

Personnel

Sites

Vacancies
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Personnel Form

Links to related 

documents

Insert time and 

user stamped 

notes

Goto Site record Dial phone number

Edit skills list

Assign consultant 

management

Post personnel reminder

Send Email

Allot an expense
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Sites Form

Goto Personnel record

Insert time and 

user stamped 

notes

Dial phone number

Edit skills list

Assign consultant 

management

Post site reminder

Send Email

View website

Goto Vacancy record

Allot an expense

Links to related 

documents
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Vacancies Form (page 1)

Goto client Personnel record

Post vacancy reminder

Goto client site record

Goto consultant Personnel record

Goto page two of the vacancies form

Allot an expense
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Vacancies Form (page 2)

Assign and edit consultant vacancy activity records

Insert time and 

user stamped 

notes

Edit skills list

Goto page one of the vacancies form

Assign and edit consultant vacancy ownership and billing records

Links to related 

documents

Goto related 

Invoice record
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Reminders

1
2

Use the PRS integrated messaging to post a 

reminder about the current person, site or 

vacancy to yourself, another consultant or 

to all consultants

Enter the reminder 

and press OK

Press the 

Reminders button

3
View your reminders when you logon 

or using the Reminders command in 

the Recruitment menu

4
Print your reminders in handy pocket 

fold report format
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Expenses

1

2

Use the integrated PRS expenses management 

system to allot an expense to a person, a site or 

a vacancy then use the Expenses Tool to 

selectively view and print expenses
Enter the expense 

and press OK

Press the Expenses

button on the 

Personnel, Sites or 

Vacancies forms

Use the Expenses Tool to 

select, view and print expenses

Print selected expenses
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Email

The PRS includes a tightly integrated 

Email dispatch and logging system that 

automates candidate and client 

messaging
Include attached documents

Email resumes, linked documents and 

acknowledgements directly from the PRS

Use the Mail Tool to 

selectively view and print 

Email messages

Insert a Mail Template containing 

your own customised responses

Post a follow-up reminder

Customise your mail signature

Mail Templates and Mail Tool functionality is only available if your Email client is Microsoft Outlook
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Finding Data

Find Personnel Records

Find Vacancy Records

Skills based searches

Here are just a few of the ways 

you can search for data
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Candidate/Consultant Activity

Candidate vacancy 

activity can be 

recorded and 

reported

Enter Candidate activity

records from Page 2 of 

the Vacancies form

One of a number of 

Consultant activity 

reports
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Document Linking

PRS Personnel, Site and 

Vacancy document lists

Application associated with linked document
Open document / link document
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Document Searches

Open the Document 

Search Tool (in the 

Recruitment|Tools

submenu)

Press Goto button to open 

found documents

1

2

3

Enter search criteria and 

press Find Now

Use the Document Search Tool to find words or 

phrases in Microsoft Word documents

Page 23



Exporting Data

1

Use the Reports Export command to save PRS 

data in a number of electronic file formats

Select the desired export format 

and press OK2

3

Preview the desired report then 

execute the Reports|Export...

menu command

You can new use  the exported file 

data in other applications
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Integrated Mail-Merge

Open Document 

Manager Tool (in the 

Tools menu)

1

The Document Manager Tool can be used to create, 

open and export selected Personnel records to 

Microsoft Word mail-merge documents

Open mail-merge document 

with selected Personnel data

2

3

Select the merge data source
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Off-line Database Access

1

The Offline Access 

function maintains a 

local copy of the shared 

PRS database which is 

useful for mobile 

workers using laptop 

computers

Select the off-line update period and 

press OK2

Execute the Offline Access menu command
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Export PRS Data to Palm PC

1PRS Vacancies, Personnel and 

Reminders can be exported to 

Palm PCs

Execute the Tools|Export...

menu command

Select the data you want to export 

to your Palm PC and press OK2

To find out how to configure Palm PC exports please consult:

1. PRS Administrators Guide

http://www.methods.co.nz/prs/prs_admin_guide.pdf

2. PRS Essential Reference

http://www.methods.co.nz/prs/prs_essential_ref.pdf

Press the OK button then 

HotSync the data to your 

Palm PC
3
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Invoice Customisation

The PRS supports multiple invoice 

series. You can fully customise invoice 

layouts by editing the Invoice 

Templates using Microsoft Word.

To create and edit Invoice Types 

excute the Invoice Types menu 

command from  the Tools|Setup

submenu

To create a new invoice 

template or edit an existing 

one press the ellipsis button
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Rostered Vacancies

Rostered Vacancies are multi-person shift oriented vacancies that are managed using the PRS 

Roster Tool, Personnel Roster and Vacancy Roster. 

1

3
Roster entries are billed and paid 

using the Process Roster...

command2
Use Roster commands to select, 

add, copy, delete and print roster 

entries

Roster entries can be managed 

using the Tools|Roster menu 

command (or by opening 

Personnel or Vacancy Rosters 

directly from the Personnel and 

Vacancies forms)
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Timesheets

Contract vacancy timesheets manage contractor payments, client invoicing and 

consultant commissions.

Timesheets are created and 

viewed from the Vacancies form
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Timesheet Tools

The PRS Timesheet Tools allow bulk timesheet creation and management, making it easy to 

process large numbers of contractors

1
New timesheets are created in bulk using the 

Tools|Timesheets|New... menu command

2
Timesheet management tasks 

can be applied to all selected 

timesheets
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Publish Vacancies

Enter vacancy publication details for 

export to HTML web files and other 

file formats (see next slide)

Publish long and short

vacancy descriptions directly 

from the Vacancies form

Page 32



Export Published Vacancies

Use the PRS Vacancy 

Publication tool to 

create permanent 

and contract HTML 

vacancy indices plus 

linked vacancy detail 

pages

1
Open the Vacancy Publication Tool

(from the Tools menu)

2
Select vacancies for publication 

then press the Export... button

3
Create linked HTML 

vacancy indices and 

detail pages

User customisable HTML 

publication templates

Index entries linked to 

vacancy detail pages

Optional CSV, 

Excel and other 

export formats
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Reports

The PRS has over two dozen distinct CRM and financial 

reports. User options result in literally hundreds of report 

combinations.

Here is just one example. We’ll leave it up to you to explore 

more reports in the Reports menu.

One of a number of 

Consultant activity 

reports

1
Choose a report from 

the PRS Reports

menu

3
Preview and print 

the report

2
Customise the 

report options
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Database Audits

Check the integrity of your data 

by running PRS data audits

Open the Database Audits form using the Audit

item in the Reports menu.1

2

3

Select the audits and the Audit 

Level you wish to report

Run the audit report
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The PRS is a product of methods: Recruitment Systems Limited.

For pricing or more information about the PRS call us or visit our 

website at http://www.methods.co.nz/prs

Call Peggy Lee:

Phone +64 9 415 6260

FAX +64 9 415 6289

Mobile +64 25 766 146

EMail support@methods.co.nz

Web Site: http://www.methods.co.nz/prs

Postal Address:

methods: Recruitment Systems Limited

Box 300-570, Albany

Auckland

NEW ZEALAND

Contact Information
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